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 Midas for the Macintosh

By N.V.King
Overview
Midas for the Macintosh is an implementation of the Midas data analysis package for the Apple Macintosh family of computers. This is achieved through a graphical user interface which acts as a front-end to the Midas kernel, common to all versions of Midas, regardless of whether they are running under the Mac OS, SunView, DOS or Windows.

Minimum Requirements
Macintosh and System Software
Midas for the Macintosh is designed to operate on all Macintosh and Power Macintosh computers having System 7.1 or higher and 32-Bit Color Quickdraw. Since 32-Bit Color Quickdraw requires a 68020 processor or higher, Midas will not operate on 68000-based systems. Midas does not require a Floating Point Unit.

Memory

It is recommended that Midas has at least a 2MB application partition. However, the amount of memory Midas requires ultimately depends on the size of the plots produced. For more information, see “Memory Considerations” in the “Macintosh User Interface” chapter.

Display

Midas will operate on black and white displays, however a display with 256 colors or shades of gray is recommended for optimum viewing of spectral data. For more information, see the “Spectral Data” menu item in the “Options Menu” chapter.

Background Processing

With System Software that already includes the Thread Manager, or with the Apple Thread Manager installed in the Extensions folder, Midas can perform background processing. This allows you to continue to work in other applications while Midas performs lengthy tasks such as opening files and plotting. For more information, see the “Backgrounding” menu item in the “Options Menu” chapter.

Contacting the Author

I would appreciate your input on Midas for the Macintosh.  Please send any comments, suggestions or bug reports to the following e-mail address:

nking@eworld.com

The Macintosh Interface
Introduction
The Midas 1.0 application is composed of a Macintosh user interface, which acts as a front-end to the Midas Kernel, and the Kernel itself.  The Kernel is the same regardless of the operating system under which Midas is running, and is responsible for operations such as opening files and producing plots.  Plots are sent back to the front-end as a series of graphics commands, where they are rendered.  In addition, messages from the Kernel are received and displayed in a seperate window.

Where possible, Midas conforms to the standard Macintosh user interface.  When a file is opened, a resizable window appears, into which all plotting performed.  All the standard Midas commands are implemented through menus in the menubar.  Some of these commands and most of the settings are also available through the toolbar along the top of the plot window.  For more information on using the toolbar, see “The Toolbar” below.

Due to the design of the Kernel, Midas can only open one file at a time.  It is possible, however, to make a copy of the Midas application and run both applications simultaneously, allowing you to work with two files.  The menubar will reflect the settings of the currently active plot window, just as it would if two files were open in the same application.

Memory Considerations
The size of the current plot determines how much memory the Midas application requires. The default 2MB application partition will handle plots up to about 640x480. To avoid running out of memory with plots greater than 640x480 you must ensure that the application partition for Midas is large enough to accomodate the resulting plot.

To change the size of the application partition, select the Midas application within the Finder and choose Get Info from the File menu. Enter the minimum and preferred sizes for the application partition in the area marked 'Memory Requirements'. The minimum size specifies the minimum amount of memory needed to launch Midas. The preferred size specifies how much memory Midas will attempt to reserve for itself. If this amount is not available, Midas will reserve all the remaining memory. If either of these values is less than the recommended size of 2MB, you may proceed but Midas may crash.
About File Types
Files from non-Macintosh sources, for example PDS CD-ROMs, do not contain sufficient information to allow Midas to determine their format automatically. This means that before opening these files, the File Type setting within Midas needs to be adjusted accordingly. This can be performed through the pop-up menu in the Open dialog box when choosing a file to open, or through the Settings menu. If the file is a fixed record length file and the records are not the default 1872 bytes in length, the record length must also be set. This can be performed through the “Options…” button in the Open dialog box, or through the “Record Length…” item in the Settings menu.

Once a file has been opened successfully, the file can be saved as a Midas file. This allows the File Type to be set automatically when the file is subsequently opened. In addition, files can be opened from within the Finder, launching Midas if necessary.

The Toolbar

The plot window has a toolbar to allow easier access to menu commands and to the current settings. An example toolbar, showing the Time Range of the current file, is shown below:
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Fig 1.  Example toolbar

The first part of the toolbar contains buttons for the First, Prior, Replot, Next and Last commands, and a display of the current position within the file, shown as a percentage. These controls are always available, regardless of the current File Type or Plot Mode.

The second part of the toolbar displays a variety of information and editable values. A range of toolbars are available. To select a specific toolbar, click on the Toolbar Selector and choose a new toolbar from the pop-up menu. You can also use the menu shortcuts 
 1 to 
 6 to select a toolbar.  Depending on the current File Type and Plot Mode, some toolbars will not be available. Sometimes, changing a setting will make the current toolbar invalid. If this happens, the toolbar will show  (No longer valid).

•
Toolbars Available

The following is a list of toolbars available, with the File Types and Plot Modes for which they apply:
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Fig 2.  Time Range for Low Rate files (top) and Time Stamp for High Rate files (bottom)
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Fig 3.  Modes for Low Rate files (top) and for High Rate files (bottom)
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Fig 4.  Levels for Low Rate files, Unbinned Spectrum or Binned Spectrum Plot Modes
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Fig 5.  Range for Low Rate files, Unbinned Spectrum or Binned Spectrum Plot Modes (top), for Low Rate files, Unbinned TomPlot or Binned TomPlot (middle) and for High Rate files, High Resolution Plot Mode (bottom)
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Fig 6.  Ignored Data for Low Rate files, Unbinned Spectrum or Binned Spectrum Plot Modes (top), for Low Rate files, Unbinned TomPlot or Binned TomPlot Plot Modes (bottom)
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Fig 7.  Comment for all File Types, all Plot Modes

The following is a description of the different types of fields displayed in the toolbar:
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Fig 8.  Numeric field with name and step buttons
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Fig 9.  Numeric field with name, units and step buttons
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Fig 10.  Numeric field with name, units, pop-up menu and step buttons

In the above examples, the values for Start Channel, Duration and Brightness can be adjusted either by editing the Value portion of the field, or by clicking on the Step Up or Step Down buttons.  The step value varies according to the type of information being entered.  For example, Start Channel steps 1 channel at a time, Duration steps 1 minute at a time, whereas Brightness, a percentage, steps 10% at a time.  If available, the pop-up menu can be used to choose from a list of common values.
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Fig 11.  Text field with pop-up menu

In the above example, the text, which in this case is the Comment shown at the bottom of each plot, can be changed by editing the Text portion of the field.  In addition, the pop-up menu can be used to quickly set the Comment to None or to the Filename of the currently open file.
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Fig 12.  Mode field with name and pop-up menu

In the above example, the Plot Mode can be changed by using the pop-up menu.  Sometimes, depending on the current Settings, there is only one choice available.  In this case, the pop-up menu arrow is not displayed and the menu is disabled.
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Fig 13.  Ignored Data and Valid Data toolbars

The Ignored Data toolbar works in a very similar way to the “Ignored Data…” dialog box when using the Settings menu.  Ignored ranges are hilited.  By default, 0 and 255 are ignored.  To ignore a range of data, move the cursor along the bar until the start value is displayed in the field on the right of the toolbar. Click and drag the cursor until the end value is displayed and release the mouse button.  To ignore a single value, click once on that value.  To extend a selection, double click inside the selection and then drag to extend it.  Several ranges of ignored data can be active at once.

The Valid Data toolbar works in a similar way to the “Valid Data…” dialog box when using the Settings menu.  To specify which channel you want to set, use the Channel field.  Entering zero or leaving the Channel field blank will specify all channels.  Clicking the “Set” button puts the values you enter for Lower Value and Upper Value into effect.

File Menu

•
Open…   
O

Displays a dialog box allowing you to choose the file to open.  By default, all file types are shown.  To show only files previously saved as Midas files, uncheck the “Show All” box.  The File Type of the currently selected file is shown at the bottom of the dialog box.  If the file has previously been saved as a Midas file, the File Type will be set automatically.  If the file is of an unknown type, you must ensure that the File Type setting is appropriate for the file.  If you have not already done this using the Settings menu, use the pop-up menu at the bottom of the dialog box.

If you need to set the Record Length for fixed record length files, click the “Options…” button.  For more information, see the “Record Length…” item in the Settings Menu description.

A window will appear and the file will be opened.  During opening, Midas determines which modes are present in the file.  If any of the current Settings are not appropriate when opening is complete, they will be set to their default values and a warning will be issued.

•
Close   
W

Closes the current file and plot window.  Since it may have taken a long time to open the file, you will be asked to confirm the close operation.

•
Save File Type…   
S

Saves the current file as a Midas file.  This allows Midas to set the File Type automatically when the file is opened in the future.  It also allows files to be opened directly from the Finder.

•
Bin File…

Bins the entire file.  Since this can take a long time with large files, a dialog box will appear asking you to confirm this command.

•
Export Picture…

Exports the current plot as a PICT file.  A dialog box will appear asking you where to save the document.  The document is saved in PICT format, and can be opened by any graphics application or opened directly in the Finder if TeachText or SimpleText is available.

•
Page Setup…

Allows you to change the printing options for the current printer.  Any changes you make to the Page Setup are stored and are recalled the next time you use Midas.

•
Print…   
P

Prints the current plot.  To ensure fast printing of black and white plots, click the “Black & White” button.  For spectral plots produced using the “Grayscale” or “Color Spectrum” options, click the “Color/Grayscale” button.  This will allow your printer to use the best possible shading available.

•
Print All…

Prints the entire file.  See “Print…” for more information.

•
Print Remainder…

Prints the remainder of the file from the current position.  See “Print…” for more information.

•
Quit   
Q

Quits Midas and returns to the Finder.  If a file is open you will be asked to confirm this command.

Edit Menu

•
Cut   
X

If a toolbar field is active, “Cut” copies the selected text to the Clipboard and deletes the selection. If no toolbar field is active, “Cut” copies the current plot to the Clipboard and clears the plot window.
•
Copy   
C

If a toolbar field is active, “Copy” copies the selected text to the Clipboard.  If no toolbar field is active, “Copy” copies the current plot to the Clipboard.  The plot is copied in PICT format, and can be pasted into virtually any graphics application for editing.
•
Paste   
V

If a toolbar field is active, “Paste” inserts the text currently in the Clipboard into the field.  If no toolbar field is active, “Paste” is not available. 

•
Clear

If a toolbar field is active, “Clear” deletes the currently selected text. If no toolbar field is active, “Clear” clears the plot window.
•
Select All   
A

If a toolbar field is active, “Select All” selects all the text in field.  If no toolbar field is active, “Select All” is not available.

Plot Menu

•
Plot…   
G

For Low Rate files, “Plot…” allows you to specify the Start Time (Year, Day, Hour and Minute) of the plot. To facilitate entry of a valid Start Time, the Time Range of the file is shown. Clicking “Use Defaults” sets Start Time to the start of the file.

For High Rate files, “Plot…” allows you to specify the Line and Datum of the plot. Clicking “Use Defaults” sets Line and Datum to zero.

or
Plot Full Frame   
G
“Plot Full Frame” plots the entire High Rate file in a single plot.  Since Line and Datum do not apply, no dialog appears.  “Plot Full Frame” is only available with High Rate files in Low Resolution Plot Mode.
•
Replot   
R

Plots the current plot again using the current Settings and Options, resizing the plot if necessary.

•
First   
F

For Low Rate files, “First” plots the first data in the file corresponding to the current Spacecraft Mode and PRA Mode.

For High Rate files in High Resolution Plot Mode, “First” plots the first set of data points in the file, i.e. at Line 0, Datum 0.  The number of points plotted is specified by the Data Points setting.  “First” is not available in Low Resolution Plot Mode.

•
Last   
L

For Low Rate files, “Last” plots the last data found in the file corresponding to the current Spacecraft Mode and PRA Mode.

For High Rate files in High Resolution Plot Mode, “Last” plots the last set of data points in the file.  The number of points plotted is specified by the Data Points setting.  “Last” is not available in Low Resolution Plot Mode.

•
Prior   
[

For Low Rate files, “Prior” plots the prior data found in the file corresponding to the current Spacecraft Mode and PRA Mode.

For High Rate files in High Resolution Plot Mode, “Prior” plots the prior set of data points in the file.  The number of points plotted is specified by the Data Points setting.  “Prior” is not available in Low Resolution Plot Mode.

•
Next   
]

For Low Rate files, “Next” plots the next data found in the file corresponding to the current Spacecraft Mode and PRA Mode.

For High Rate files in High Resolution Plot Mode, “Next” plots the next set of data points in the file.    The number of points plotted is specified by the Data Points setting.  “Next” is not available in Low Resolution Plot Mode.

•
Cancel Plot   
.

Cancels the current plot. This menu item is only available if the plot is being processed in the background.

Settings Menu
•
File Type

Allows you to set the current File Type from a hierarchical menu.  Before opening a file that has not previously been saved as a Midas file you must ensure that the File Type is correct.  If the file is a Fixed Record Length file,  you should also set the Record Length (see “Record Length…” below).
•
Record Length…

Allows you to set the current Record Length for Fixed Record Length files.  To set the Record Length to the default of 1872 bytes, click “Use Default”.
•
Plot Mode

Allows you to set the current Plot Mode from a hierarchical menu.  Only modes appropriate for the current File Type are shown.
•
Spacecraft Mode

Allows you to set the current Spacecraft Mode from a hierarchical menu listing all possible modes.  If a file is open, only the modes actually present in the file are shown.
•
PRA Mode

Allows you to set the current PRA Mode from a hierarchical menu listing all possible modes.  If a file is open, only the modes actually present in the file are shown.
•
Range…

Allows you to set the range of the next plot.  The values shown in the dialog box depend on the current Plot Mode:

Unbinned Spectrum
Start Channel, End Channel, Duration

Binned Spectrum
Start Channel, End Channel, Duration

Raw DN
None

Unbinned TomPlot
Start Channel, Number of Channels, Duration

Binned TomPlot
Start Channel, Number of Channels, Duration

Low Resolution
None

High Resolution
Channel, Data Points, Strips

•
Levels…

Allows you to set the Brightness and Saturation levels of the next plot.  These settings are only available if the current Plot Mode is Unbinned Spectrum or Binned Spectrum.

•
Ignored Data…

Allows you to set the ranges of data values that are ignored.  These settings are available if the current Plot Mode is Unbinned Spectrum or Binned Spectrum.

Ignored ranges are hilited.  By default, 0 and 255 are ignored.  To ignore a range of data, move the cursor along the bar until the start value is displayed in the field on the right of the dialog box. Click and drag the cursor until the end value is displayed and release the mouse button.  To ignore a single value, click once on that value.  To extend a selection, double click inside the selection and then drag to extend it.  Several ranges of ignored data can be active at once.  To revert to the default setting of 0 and 255 ignored, click “Use Defaults”.

or
Valid Data…

Allows you to set the ranges of data values that are valid.  These settings are available if the current Plot Mode is Unbinned TomPlot or Binned TomPlot.

Ranges can be applied to a specific channel or to all channels at once.  To set all channels, check the “All Channels” box.  Otherwise, enter the channel number in the Set Channel field.  Then enter the Lower Value and Upper Value and click “Set”.  To revert to the default setting of 0 to 255 on all channels, click “Use Defaults” and click “Set”.

•
Comment…

Allows you to set the Comment text which appears at the bottom of each plot.  By default,  no comment is displayed.  To set the comment to the file name of the current file,  click “Use Filename”.

Options Menu
•
Append File Type to Name

If this option is checked, the File Type of the file is appended to the name of the file shown in the window title bar.

•
Show Kernel Messages

If this option is checked, the last two messages from the Kernel are shown in a seperate window. This window can be resized to show  up to the last ten messages.

•
Sound Effects

If this option is checked, buttons and pull-down menus in the Toolbar will “click” when used.

•
Beep When Finished

If this option is checked, Midas will alert you when the current plot has completed.

•
Backgrounding

If this option is checked, Midas will open files and plot in the background, allowing you to work in other applications.  If it is not checked, tasks will be processed in the foreground and you will be unable to work in other applications until the task is complete.  If a task is already being processed in the background, unchecking this option will suspend the task.  To resume processing of the task, re-check this option.

This option is only available if your Macintosh has the Thread Manager extension installed in the Extensions folder, or has System Software that incorporates the Thread Manager.

•
Plot Size

Allows you to specify the size of the next plot. “Fixed” keeps the plot at the current size. “Match Window” causes the plot to be resized to fit the current plot window. “Match Printer Page” causes the plot to be resized to fit the current printer page.

•
Fixed Text Size

If this option is checked, all text will be displayed in 9 point.  If text sizes are erratic, you may wish to use this option to limit all text to 9 point.

•
Font

Allows you to specify the font used for text when plotting.  All fonts installed in your System File (or Fonts folder for System 7.1 and above) are available for use in Midas.

•
Spectral Data

Allows you to specify the way spectral data is plotted. “Black & White” uses pixel dithering to represent different shades of gray and is designed for use on Macintoshes with monochrome displays. “Gray Scale” is designed for use on Macintoshes with displays capable of 16 or more shades of gray. “Color Spectrum” is designed for use on Macintoshes with displays capable of 16 or more colors. In color plots, low intensity data is blue, high intensity data is red.

•
Background Color

Allows you to specify the background color of the plot. “White” is the default. “Black” offers better contrast for spectral plots.

